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Chapter 1 - Becoming Familiar with
LPS

The TimeStorm Linux Profiling Suite (LPS) is a Linux profiling product that allows developers of em-
bedded Linux products to find performance bottlenecks in their code. LPS is installed as a plug-in to
TimeStorm and is used on a PC host. Refer to Getting Started with TimeStorm for a list of supported op-
erating systems.

1.1 About LPS
LPS uses OProfile, which is a system-wide profiler for Linux systems. All of your code is profiled, in-
cluding: hardware and software interrupt handlers, kernel modules, the kernel, shared libraries, and ap-
plications. OProfile transparently collects information about your kernel and all running systems without
introducing much overhead. OProfile uses CPU performance counters, which are hardware registers that
count particular events such as CPU cycles, to profile your code. Whenever a particular event occurs,
the information is recorded. OProfile uses this data to create profiles for binary images. LPS then en-
ables you to view both a statistical analysis and a graphical analysis of the results and to view the annot-
ated source code so that you can pinpoint any performance issues quickly and easily.

To use LPS, you must install both TimeStorm and LPS, as described in Getting Started with TimeStorm.
You also must have the appropriate license file to be able to use the software. Refer to Getting Started
with TimeStorm for details about licensing information.

1.2 About TimeStorm
TimeStorm is an integrated development environment (IDE) that is customized to create applications
and other binaries for Linux systems.

In addition to the basic features of the TimeStorm IDE, you can purchase TimeStorm plug-in compon-
ents to extend TimeStorm’s capabilities, including the TimeStorm Target Configurator, the TimeStorm
LPS, and the TimeStorm Linux Verification Suite (LVS).

TimeStorm IDE provides standard Linux application development capabilities, including:

• A GUI-based integrated development environment for creating C, C++, and Java applications

• Integration with various Linux toolchains to cross-compile your projects on your workstation for use
on a target processor and Linux operating system

• Automatic code deployment and remote execution capabilities

• A remote debugging environment

TimeStorm software is installed and used on a development host machine. Windows, Solaris, and Linux
operating systems are supported for the TimeStorm host; however, the LPS plug-in is not available for
Solaris systems. The TimeStorm host communicates with the target Linux system by using a network
connection or a direct connection.

More complete information about configuring a TimeStorm development environment is available in the
Getting Started with TimeStorm document that is included as a PDF with this software distribution.

For information about TimeStorm IDE features, including information about setting up software li-
censes, creating and debugging C or C++ applications, installing toolchains, and other basic capabilities,
read the TimeStorm Online Documentation.
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1.3 Documentation Provided with LPS
This guide describes the features in LPS and explains how to use them. It also includes a step-by-step
tutorial with examples.

Additional documentation is provided with LPS. PDF documents are located in the /doc directory of the
software distribution and are also installed with your TimeStorm software in a subdirectory named doc.

Online help is provided with LPS in the form of HTML files rendered in a browser by the workbench.
The online help includes several help sets; the TimeStorm LPS Online Documentation describes inter-
faces and tasks that are specific to LPS. To access the TimeStorm LPS Online Documentation, select
Help > Help Contents from the main TimeStorm menu. The online help is rendered in the default
browser for your system. To change the browser, select Windows > Preferences > General > Web
Browser.

Note:
For more information about OProfile, refer to the OProfile Manual found at:

http://oprofile.sourceforge.net/doc/index.html

1.3.1 TimeStorm Documentation
The following TimeStorm documents are provided:

• Getting Started with TimeStorm (/doc/getting_started.pdf) includes requirements, installation
instructions, and setup steps (including software license installation) for all TimeStorm software.
Read this before installing the TimeStorm IDE and LPS software.

• The TimeStorm IDE User’s Guide (/doc/user_guide_ts.pdf) explains the basic operations of
TimeStorm.

• The TimeStorm Online Documentation describes the interfaces and typical tasks that are part of
TimeStorm.

• TimeStorm Release Notes – The release_notes_ts.txt file contains late-breaking TimeStorm
product information and describes workarounds for any existing problems.

1.3.2 LPS Documentation
The following LPS documents are provided:

• This document, the TimeStorm Linux Profiling Suite User’s Guide (/doc/user_guide_lps.pdf) is
located in the /doc directory of your TimeStorm distribution, and is installed when you install the
LPS software. It contains information about configuring and using the LPS features. The LPS docu-
ments are installed only if the Linux Profiling Suite documentation component was selected during
installation.

• The TimeStorm LPS Online Documentation gives detailed information about features that are in-
cluded with the LPS plug-in.

• LPS Release Notes – The release_notes_lps.txt file contains late-breaking LPS product informa-
tion and describes workarounds for any existing problems.

Becoming Familiar with LPS
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1.3.3 Target Configurator Documentation
The TimeStorm Target Configurator is an optional component that can be added to TimeStorm.

• The TimeStorm Target Configurator User’s Guide (/doc/user_guide_tc.pdf) is located in the
/doc directory of your TimeStorm distribution, and is installed when you install the Target Config-
urator software. It contains information about configuring and using Target Configurator features.
The Target Configurator documents are installed only if the Target Configurator documentation
component was selected during installation.

• The TimeStorm Target Configurator Online Documentation gives detailed information about fea-
tures that are included with the Target Configurator plug-in.

• Target Configurator Release Notes – The release_notes_tc.txt file contains late-breaking Target
Configurator product information and describes workarounds for any existing problems.

1.3.4 LVS Documentation
The TimeStorm Linux Verification Suite (LVS) is an optional component that can be added to
TimeStorm.

• The TimeStorm Linux Verification Suite User’s Guide (/doc/user_guide_lvs.pdf) is located in the
/doc directory of your TimeStorm distribution, and is installed when you install the LVS software. It
contains information about configuring and using the LVS features. The LVS documents are in-
stalled only if the Linux Verification Suite documentation component was selected during installa-
tion.

• The TimeStorm LVS Online Documentation gives detailed information about features that are in-
cluded with the LVS plug-in.

• LVS Release Notes – The release_notes_lvs.txt file contains late-breaking LVS product informa-
tion and describes workarounds for any existing problems.

1.4 Contacting TimeSys
TimeSys has made every effort to ensure that this document is accurate and error-free. If you find an
error or have suggestions that would improve it, please let us know by sending e-mail to
documentation@timesys.com.

If you have questions about or problems with the TimeSys platform, or if you think you have discovered
an error in the software, log onto the LinuxLink Help page at:

https://linuxlink.timesys.com/help

If you need further assistance, call for technical support at 1-888-432-8463.

Sales information can be obtained by sending e-mail to sales@timesys.com or by calling
412-232-3250. Additional contact information is available on the TimeSys web site at:

http://www.timesys.com/

Becoming Familiar with LPS
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1.5 LPS Requirements
The LPS hardware and software requirements are listed as part of the TimeStorm prerequisites in
Getting Started with TimeStorm.

You must install some additional host utilities and put them on your path before you start TimeStorm, or
you will receive an error message when you try to use LPS. The required utilities are opxml and
opimport, which is included in oprofile.

Refer to Host Utilities Installation in Getting Started with TimeStorm for more information about
installing these utilities.

Note:
You must have OProfile version 0.91 or higher installed on your target to be able to use LPS.
For more information about OProfile, refer to http://oprofile.sourceforge.net/.

You can download OProfile from the Repository section of TimeSys LinuxLink at
https://linuxlink.timesys.com/repository/ or from http://oprofile.sourceforge.net/download/.

On Windows hosts, the file might be saved with a tar.tar extension, which needs to be re-
named as a tar.gz extension. Refer to the OProfile documentation for installation instructions.

1.6 What’s New in LPS
LPS 1.0.2 includes the following changes and improvements over previous versions:

• Improved processor support for profiling – In addition to the processors supported by previous
versions of LPS, LPS 1.0.2 also supports the following processors:

• Power5+
• Xen
• Intel Core Duo and Core 2
• MIPS 5K, 20K, 25K, and 34K
• Cell BE
• POWER6
• PPC970MP
• AMD Family 10
• PA Semi PA6T
• ARM11
• ARM MPCore

• Better support for local profiling – In some cases, previous versions of LPS did not allow profiling
on a local host. With LPS 1.0.2, OProfile can be used to test how an application is performing on a
local Linux host, making information gathering quicker and easier.

• New opxml package required – If you are upgrading your version of TimeStorm LPS, you will
need to access the LinuxLink Repository and download the latest version of opxml, as described in
Section 3.2.4 of Getting Started with TimeStorm.

Becoming Familiar with LPS
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1.7 The Workbench
LPS 1.0.2 is provided as a plug-in to TimeStorm 3.2.2. You can use LPS in conjunction with other
TimeSys products that are plug-ins to TimeStorm. TimeStorm is built on the Eclipse™ software architec-
ture, a widely used open-source application development framework, originally developed by IBM and
now in use throughout the Linux industry. TimeStorm’s proprietary features are implemented as plug-
ins to the Eclipse development environment. Therefore, you can use TimeStorm in conjunction with
auxiliary Eclipse-based plug-ins that are available from other vendors. Additional information about Ec-
lipse is available at http://www.eclipse.org/.

TimeStorm’s fundamental desktop development environment is called the workbench. The workbench
consists of a number of perspectives. A perspective consists of editors, windows, and views within
TimeStorm that show different aspects of the application that you are developing. Views display inform-
ation about your projects and workspace, and look like windows within the main TimeStorm work-
bench.

1.7.1 Projects, Files, and Workspaces
Projects are collections of related files that can be managed as a unit. You can work with multiple
projects at the same time. In LPS a project can contain a group of profiling sessions for a particular tar-
get. Files are always associated with projects. Typically, files that are part of a project are stored in the
project’s directory; however, you can import files that are stored in another location.

Projects are associated with a workspace, which is a virtual set of files that is associated with a particular
instance of TimeStorm. A workspace is created when you start TimeStorm initially. Each time you sub-
sequently start TimeStorm, you either open the same workspace or have the option of creating a new
workspace. All projects and files that are available in TimeStorm and LPS are part of that workspace.
Every file that you want to use must either be created in or imported into the workspace.

1.7.2 Welcome Page
When TimeStorm is initially launched, it loads a Welcome page. Click the Workbench icon to open
TimeStorm. If you want to display the Welcome page again, select Help > Welcome from the menu. To
close the Welcome page, click the x on its tab.

Becoming Familiar with LPS
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1.7.3 Working with Perspectives
When TimeStorm initially opens, it loads the C/C++ perspective by default, as shown in Figure 1.1.

Figure 1.1. The TimeStorm workbench (C/C++ perspective)

To open a perspective, either click the Open Perspective button in the shortcut bar in the top right

of the workbench, or select the Window > Open Perspective > Other option from the toolbar, and then
choose the perspective from the list that is displayed in the Select Perspective window.

The list shows options corresponding to the TimeSys products that have been installed. However, you
also must have the appropriate license file installed to be able to use those products. Refer to Getting
Started with TimeStorm for details about licensing information.

You can click a perspective button in the shortcut bar in the top right of the workbench to switch
between perspectives that are already open. The perspective you are currently working with is shown in
the title of the workbench window and in the shortcut bar as a pushed-in button image.

You can rearrange the views and editors in your workbench as you wish. By default, your current ar-
rangement is saved when you exit and is re-established when you start TimeStorm again.

Becoming Familiar with LPS
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1.7.4 The LPS Perspective
To open the LPS perspective initially, you must select the Window > Open Perspective > Other op-
tion and choose LPS from the list that is displayed in the Select Perspective window, as shown in
Figure 1.2.

Figure 1.2. Select Perspective window

The LPS perspective opens and the LPS perspective button appears in the shortcut bar.

You can now use this button to switch perspectives.

Becoming Familiar with LPS
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Figure 1.3 shows the LPS perspective, along with its various features:

Figure 1.3. The LPS Perspective

To maximize a view, double-click the tab at the top of the view. To return the view to its original size,
double-click the tab again.

The LPS perspective consists of the features listed in Table 1.1:

Table 1.1. Features in the LPS Perspective

LPS Feature Described in...

Profile toolbar button (in addition to the standard toolbar buttons) Section 4.1

Profiling Monitor view Section 3.1

Profile Analysis view Section 3.3

Debug view Section 3.4

Profile Graphical Analysis view Section 3.5

Properties view Section 3.6

Log view Section 3.7

Profile Settings view Section 3.8

Console view Section 3.9

Detailed information about each of these features also is provided in the TimeStorm LPS Online Docu-
mentation.

Becoming Familiar with LPS
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1.8 LPS Terminology
When using LPS, it is important to understand the terms described in the following sections:

1.8.1 LPS Profiling Session
An LPS profiling session is a collection of profiling data that has been run on your code on a particular
target. The sessions are grouped by the target’s IP address, and then by LPS project in the Profiling
Monitor view. A session is created either when you run a profile launch configuration to collect data
about your code, or when you import profiling data into LPS.

You can analyze individual sessions in the Profile Analysis view and the Profile Graphical Analysis
view. You can look at the OProfile daemon log for a session in the Log view, or check the settings for a
session in the Profile Settings view. You can compare the data for two sessions in the Profiling
Monitor view or compare the same source file for two sessions by using the Compare Profile Data
button in the Debug view’s toolbar.

Refer to Section 3.1, Profiling Monitor View, and to Section 3.2, Accessing the Features in the Profiling
Monitor View, for more information about what you can do with an LPS session.

1.8.2 Target
In the Profiling Monitor view, sessions are grouped by the IP addresses of the targets on which they are
run. The targets are, in turn, grouped under LPS projects. Refer to Section 3.1, Profiling Monitor View,
for more information about the groupings.

Refer to Chapter 2, Target Setup, for information about registering your target with TimeStorm IDE.
You need to register your target so that you can either import profiling data or you can create and run
profile launch configurations, which are used to profile your code. After a target is registered, it is recog-
nized by and can be used by TimeStorm and any of its plug-ins.

1.8.3 LPS Project
An LPS project is created when you import profiling data or when you create a profile launch configura-
tion to collect data. An LPS project contains one or more targets that have had one or more profiling ses-
sions run on them. Refer to Section 3.1, Profiling Monitor View, for more information about LPS
projects.

1.9 Using LPS
To use LPS, perform the following steps:

1. Install TimeStorm and the LPS plug-in on your host and start them, as described in Getting Started
with TimeStorm.

2. Install OProfile version 0.91 or higher on your target, if it is not already installed. Refer to
http://oprofile.sourceforge.net/doc/index.html for more information.

3. Configure your target and verify network connectivity, as described in Chapter 2, Target Setup, in
this guide. This includes the following tasks:

a. Register your target and configure the settings for your target, as described in Section 2.1,
Adding a Target to the List of Registered Targets.

b. Verify that there is an active link between the host and the target, as described in
Section 2.4, Checking the Connection from the Host to a Registered Target.

Becoming Familiar with LPS
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4. Either import OProfile data into an LPS project, as described in Section 3.2.11, Importing Data to
Create a Profiling Session, or create an LPS project launch configuration by clicking the Profile
button in the main menu and selecting Profile from the drop-down menu, as described in
Chapter 4, Profile Launch Configurations.

5. Depending on what you want to do with the data, right-click in the Profiling Monitor view and
choose from the Analyze, Analyze Graphically, Log, or Profile Settings options. Refer to
Chapter 3, LPS Views, for details about these options.

6. After you examine the results in the Profile Analysis or Profile Graphical Analysis views, you
might want to debug the code, by clicking the Debug button in the main menu, as described in
Section 3.4, Debug View.

7. After you find and fix the performance bottlenecks in your code, you can profile your code again.

8. You can check the performance improvement by comparing the two profiling sessions. To do this,
use the Compare option in the Profiling Monitor view, as described in Section 3.2, Accessing the
Features in the Profiling Monitor View.

1.9.1 Context Menus (Right-Clicking)
LPS uses context menus, which let you quickly access the most useful commands and properties related
to the object or window with which you are working. Context menus list only those commands that per-
tain to the item under the cursor.

To use a context menu:

1. Position the cursor over an item in the workbench.

2. Click the right mouse button (right-click) to display the context menu.

3. Choose the command from the context menu and release the mouse button.

Becoming Familiar with LPS
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Chapter 2 - Target Setup
This chapter describes how to set up a target for use with TimeStorm and all of its plug-ins. Before you
can run any profiling sessions, you need to register information about one or more targets with
TimeStorm by using the Targets window. In particular, LPS uses this information to determine how and
where the profiling data should be copied to the target, and to determine the method of communication
that should be used between the host and the target.

You can access the Targets window by selecting TimeStorm > Targets from the main menu, or by
clicking the Targets toolbar button .

2.1 Adding a Target to the List of Registered
Targets

To add a target to the list of those that LPS can access, click the New button in the left pane of the
Targets window. Several tabs appear in the right pane of the Targets window, as shown in Figure 2.1.

Figure 2.1. Targets window – Download tab
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2.1.1 Name Field
Enter a unique, descriptive name for your target in the Name field. The target name may not contain any
spaces.

2.1.2 Download Tab
Use the Download tab to specify how the profiling data should be transferred from the host to the target,
and where to copy it on the target. In this tab, you can select FTP, SCP, or NFS as the download method
for the data. You must fill in all of the corresponding fields for the method that you choose.

• FTP – Profiling data will be downloaded using the File Transfer Protocol (FTP).

• SCP – Profiling data will be downloaded using secure copy (SCP).

• None – The host will be connected to the target, but no data will be downloaded. You can then do
any needed downloading using the console.

• NFS – LPS will copy the data locally in the target Root File System (RFS) mounted over the Net-
work File System (NFS).

2.1.2.1 FTP/SCP Settings
The corresponding fields for both the FTP and SCP options are as follows:

• IP Address – Enter either the IP address or the hostname of the target. If you use a hostname, your
network must include access to a Domain Name Server (DNS) lookup facility.

• User Name – Enter the user name for FTP or SCP login on the target, as appropriate.

• Password – Enter a non-blank password for FTP or SCP login, as appropriate.

• Destination Directory – Enter the path to which the files will be transferred on the target. FTP set-
tings sometimes restrict the location of files copied to a directory under the home directory of the
user. Therefore, the actual destination directory depends on the configuration of your FTP software.
In some cases, directories specified in this panel are appended to the user’s home directory on the
target. Ensure that the user name that you specified has read/write permissions for the destination
directory.

• Link to Execution – When this checkbox is selected, all of the information in the fields which cor-
respond to the FTP or SCP option is automatically entered into the appropriate fields in the Execute
tab. You will not be able to edit those fields in which the information is automatically entered. This
checkbox is selected by default.

When this checkbox is cleared, you must manually enter the corresponding information into the
fields in the Telnet option in the Execute tab.

2.1.2.2 NFS Settings
The corresponding fields for the NFS option are as follows:

• RFS Base Directory – Use the Browse button to select the location of the RFS on the host. This
location is where the target’s root filesystem is mounted over NFS; for example,
/opt/timesys/linux/6.1/<arch>-std/rfs/, where <arch> is the architecture of the target being
profiled.

Target Setup
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• Destination Directory – Use the Browse button to select the location in the RFS to which the pro-
filing data will be downloaded. The directory must be within the RFS Base Directory location that
was selected.

If you use a Windows system as your RFS host, the RFS directory generally will be located under
the Cygwin root (for example, C:\Cygwin\). However, you should leave off the root part of the path
(that is, use \opt rather than C:\Cygwin\opt\).

Ensure that you have read/write permissions for the destination directory.

After you have entered the required information in this tab, select the Execute tab and enter the appro-
priate information.

2.1.3 Execute Tab
Use the Execute tab, which is shown in Figure 2.2, to specify the communication method that LPS uses
between the host and the target.

Figure 2.2. Targets window – Execute tab

From the Execute tab, you can select Telnet, SSH, or a serial connection as the communication method
between the host and the target. You must fill in all of the corresponding fields for the method that you
choose. LPS answers the login and password prompts presented by the Telnet or SSH server on the tar-
get, based on the data that you enter in this tab.

Target Setup
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• Telnet – Communication between the host and the target will occur via Telnet.

• SSH – Communication between the host and the target will occur via secure shell (SSH).

• Serial – Communication between the host and the target will occur via the serial connection.

2.1.3.1 Telnet/SSH Settings
The corresponding field for both the Telnet and the SSH options is as follows:

• IP Address – Enter either the IP address or the hostname of the target. If you use a hostname, your
network must include access to a DNS lookup facility.

2.1.3.2 Serial Settings
The corresponding fields for the Serial option are as follows:

• Skip login – If you are connecting directly to the target’s bootloader, and thus will not get a login
prompt, select this option. The rest of the common details will be grayed out.

• Serial Port – Enter the host’s serial port; for example, /dev/ttyS0. If you use this option, be sure
that the user that you specified has the proper permissions to access the serial port.

• Baud Rate – Use the drop-down menu to select the appropriate baud rate for serial communication
with your target. The default rate is 9600 bps.

2.1.3.3 Common Settings for All Options
The common fields for all three options in the Execute tab are as follows:

• User Name – Enter the user name for a Telnet, SSH, or serial login, as appropriate, on the target.

• Password – Enter a non-blank password for a Telnet, SSH, or serial login, as appropriate.

• Working Directory – Enter the directory to which control will be transferred after LPS logs in to
the target. By default, this is the same path to which the data will be transferred on the target. This
directory must already exist.

Note:
If the Link to Execution checkbox is selected on the Download tab, the information in the
fields which correspond to the FTP or SCP option is automatically entered into the common
fields and into the IP Address field in the Execute tab. When information is automatically
entered into these fields, they are not editable.

After you have entered the required information in the Execute tab, you can register the target by click-
ing the Apply button.

After you click Apply, you might want to perform a target connectivity test to verify that the target has
been registered properly and that it can communicate with the host. Refer to Section 2.4, Checking the
Connection from the Host to a Registered Target, for information about the target connectivity test. The
connectivity check does not occur automatically upon registration.
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2.2 Editing the Information for a Registered
Target

If you make a mistake while adding a target, or if information has changed for a registered target, you
can edit the information in the Name field and in the Download and Execute tabs.

To edit the information for a target, select that target from the list in the left pane of the Targets win-
dow. Then click on the appropriate tab(s) and make the desired modifications. Before you save the
changes, click the Revert button if you want to reset to the default TimeSys values. Click Apply to save
your changes. If you change the target name, be sure to enter a name that does not contain any spaces.

The options in the Download and Execute tabs are described in Section 2.1.2, Download Tab, and Sec-
tion 2.1.3, Execute Tab, respectively.

Note:
Changes made in one tab do not affect the other tab, unless the Link to Execution checkbox is
selected, in which case you cannot directly edit the Telnet or SSH information in the Execute
tab. If the Link to Execution checkbox is not selected, and you want to modify the FTP or
SCP settings, you must modify the settings in both the Download tab and in the Execute tab.

2.3 Deleting a Registered Target
If you want to remove a target from the list of targets that LPS can access, select the target in the left
pane of the Targets window and click Delete. To select multiple targets for deletion, hold either the
Ctrl key or the Shift key while choosing the targets.

You are asked to confirm that you want to delete the target(s).

2.4 Checking the Connection from the Host to a
Registered Target

After you register a target, you can verify the connection to that target at any time. Each time you add a
target or edit information for a target, TimeSys recommends that you perform a connectivity check to
verify that the host can communicate with the target. The connectivity check does not occur automatic-
ally upon registering or applying changes to a target.
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To verify connectivity to a target, select the target in the left pane of the Targets window and click the
Check Link button. The Raw Log tab becomes active when the verification process begins.

Figure 2.3 shows the Target Check – Passed message that is displayed in the Raw Log tab of the
Targets window when the host communicates successfully with a target.

Figure 2.3. Target Check – Passed message

Figure 2.4 shows the Target Check – Failed message that is displayed in the Raw Log tab of the
Targets window when the host cannot reach the target.

Figure 2.4. Target Check – Failed message

If communication to the target was not established successfully, look at the log messages that are dis-
played in the Raw Log tab. These messages might be helpful in troubleshooting the connectivity prob-
lem.
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Chapter 3 - LPS Views
The LPS perspective consists of the following views, most of which can be accessed from the context
menu in the Profiling Monitor view:

• Section 3.1, Profiling Monitor View – Allows you to display data in many of the other LPS views, to
control and compare profiling sessions, and to import data into a new LPS project.

• Section 3.3, Profile Analysis View – Displays the statistical data for an LPS session.

• Section 3.4, Debug View – Provides low-level details for a specific program that you have profiled.

• Section 3.5, Profile Graphical Analysis View – Displays the data for an LPS session in the form of a
bar graph or a pie chart.

• Section 3.6, Properties View – Displays the read-only properties for an LPS project, target, or ses-
sion.

• Section 3.7, Log View – Parses and displays the log written by the OProfile daemon for an LPS ses-
sion.

• Section 3.8, Profile Settings View – Displays the settings that were used to profile an LPS session.

• Section 3.9, Console View – Provides Telnet, SSH, and serial connection capability to the target.

These views are described in detail in this chapter and in the TimeStorm LPS Online Documentation.

3.1 Profiling Monitor View
The Profiling Monitor view shows the profile sessions in your workspace. Profile sessions are grouped
under the profiled target’s IP address. These targets are further grouped under LPS profiled projects in a
tree form, as shown in Figure 3.1.

Figure 3.1. Profiling Monitor view
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The Profiling Monitor view contains a context menu that allows you to launch other views, to import
profiled data, and to analyze the profiled data, as explained in Section 3.2, Accessing the Features in the
Profiling Monitor View.

3.2 Accessing the Features in the Profiling
Monitor View

The features in the Profiling Monitor view can be accessed by selecting a session, right-clicking in the
view, and choosing an option from the context menu, as shown in Figure 3.2. The Link to View option
can only be accessed by clicking the Link to View button in the Profiling Monitor view’s toolbar.

Figure 3.2. Profiling Monitor view menu

These features are described in detail in the following sections in this chapter.

LPS Views
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3.2.1 Link to View Button
When you press the Link to view button in the Profiling Monitor view’s toolbar, the information

in the Log view and in the Profile Settings view is updated automatically for the session that you have
selected. When this button is not pressed, you must right-click in the view and select the appropriate op-
tions from the context menu to view the log and the profile settings for your session.

3.2.2 Analyzing Data for a Profiling Session
The Profile Analysis view displays the statistical data for a profiling session. Refer to Section 3.3, Pro-
file Analysis View, for information about this view.

3.2.3 Analyzing Data Graphically for a Profiling Session
The Profile Graphical Analysis view displays the data for a profiling session in the form of a bar graph
or a pie chart. Refer to Section 3.5, Profile Graphical Analysis View, for information about this view.

3.2.4 Displaying the Log for a Profiling Session
The Log view displays a structured view of the OProfile daemon log. Refer to Section 3.7, Log View, for
information about this view.

3.2.5 Displaying the Profile Settings for a Profiling
Session

The Profile Settings view allows you to look at the profile settings for an LPS project. Refer to
Section 3.8, Profile Settings View, for information about this view.

3.2.6 Stopping a Profiling Session
To stop a profiling session for an LPS project that is currently running, right-click in the
Profiling Monitor view and select Stop. You can also stop profiling by clicking the Stop button

that is located in the toolbar for the Profiling Monitor view. No data is saved for a stopped session.

3.2.7 Renaming a Profiling Session
To rename a profiling session, select the session in the Profiling Monitor view, right-click, and select
Rename. After a session is renamed, its data is refreshed in all of the other views.

3.2.8 Deleting a Profiling Session, Target, or LPS Project
To delete a profiling session, target, or LPS project from the Profiling Monitor view, select the session,
target, or project name, right-click in the view, and select Delete. When a target is removed from the
Profiling Monitor view, all of the sessions for that target are also deleted. When an LPS project is re-
moved from the Profiling Monitor view, all of the targets in that project and all of their sessions are
also deleted. When a session is removed from the Profiling Monitor view, all of its information is re-
moved from the other views, as well.

You are always asked to confirm any deletion. When a session, a target, or an LPS project is deleted, all
of its information is removed from the workspace also.
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3.2.9 Refreshing Data for a Profiling Session, Target, or
LPS Project

To refresh the information, select the profiling session, target, or LPS project, right-click in the
Profiling Monitor view, and select Refresh.

3.2.10 Comparing Profiling Sessions
The comparison feature is useful if you have run a profiling session and then used that data to improve
your source code. After making the modifications, you might want to run another profiling session and
then compare the two to determine how helpful your improvements are.

To compare the information for two profiling sessions in an LPS project, do the following:

1. In the Profiling Monitor view, select one of the sessions that you want to compare, right-click in
the view, and select Compare.

The Compare Profile Sessions window opens, as shown in Figure 3.3.

Figure 3.3. Selecting a session for comparison
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2. In the Sessions pane, select the other session that you want to compare with the one that you previ-
ously selected and double-click that session.

The two sessions are shown side-by-side in the bottom panes of the Compare Profile Sessions
window, as shown in Figure 3.4. The lines going between the two session panes at the bottom of
the window indicate where the differences are. All of the information is read-only.

Figure 3.4. Compare Profile Sessions window

3. To review the differences between the two sessions line-by-line, click the Select Next Change ar-
row button in the middle of the window to go to the next change. To go back to the previous

change, click the Select Previous Change arrow button .

4. To see only the differences for an event for a particular program that was profiled during the two
sessions, expand the tree in the Profile Events pane and select the program for which you want to
see the changes. The program that you selected, along with the counts for that program, is dis-
played in the bottom pane, as shown in Figure 3.5. To return to the original Compare Profile
Sessions window, which shows all of the programs, click the top of the event tree that you expan-
ded in the Profile Events pane.
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Figure 3.5. Compare Profile Sessions window – image profile data comparison

In the Profile Events pane, shown in Figure 3.6, there are different icons to the left of the program
names.

Figure 3.6. Profile Events pane

These icons have the following meanings:

• – The counts have increased for this program in the newer session.

• – The counts have decreased for this program in the newer session.

• – This program was added in the newer session and did not exist in the older session.

• – This program does not exist in this session, but existed in the older session.

When you are done viewing the comparisons, click the Cancel button to close the Compare Profile
Sessions window.
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3.2.11 Importing Data to Create a Profiling Session
If you have already profiled your data using OProfile and you want to use LPS to analyze the data, you
can use the LPS Import wizard to import the data and to create a profiling session for further analysis.
To start the wizard, right-click in the Profiling Monitor view and select the Import option from the
context menu. Use the following procedure to import your data:

1. In the Import wizard, choose OProfile Data into LPS Project, as shown in Figure 3.7.

Figure 3.7. Import wizard – selecting an LPS project

2. Click Next.
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3. Configure the following information in the first Import OProfile data panel, which is shown in
Figure 3.8:

Figure 3.8. Import wizard – selecting an OProfile data folder

a. If the data that you want to import resides on a remote target, do the following:

In the Target field of the first Import OProfile data panel, use the drop-down menu to select
the target that contains the profiling data that you want to import. If the target has not been re-
gistered with LPS, click Manage Targets to add your target to the list of targets that LPS re-
cognizes. Refer to Chapter 2, Target Setup, for complete information about registering your
target.
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After you select a target, the Data Folder on Target and CPU Type fields will be filled in
automatically if the OProfile daemon is running on the target. Otherwise, an error message is
displayed, and you may select the CPU type and the data folder location on the target manu-
ally. However, LPS will not start the OProfile daemon. Click Next.

By default, the Include profiled file checkbox is selected, which means that the profiled im-
ages are uploaded from the target to the host. This helps in analyzing the profiled sources. If
you do not want any debug information for the profiled images and do not want to analyze the
source code, deselect this checkbox. In that case, only the profiled data is uploaded to the host.

b. If the data that you want to import resides on your local host, do the following:

Click the Local radio button in the first Import OProfile data panel. This option is available
only on Linux hosts. The Data Folder on Local System field is filled in automatically if the
OProfile daemon is running on the target. Otherwise, an error message is displayed, and you
may select the data folder location on the target manually. However, LPS will not start the
OProfile daemon. Use the drop-down menu to select the CPU Type. Click Next.

4. In the second Import OProfile data panel, shown in Figure 3.9, you may leave the LPS Project
field blank and LPS will supply a name for your LPS project. If you have any existing LPS
projects, you may use the drop-down menu to select one of them.

The Target field will be filled in automatically and you cannot edit it. If you selected the wrong
target in the previous panel, click the Back button to go back and select a different target.

In the Session field, you can either enter a name for your session or leave that field blank and LPS
will supply a session name in the form of a date and time stamp later when it creates the session.

Figure 3.9. Import wizard – selecting an LPS project and session
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5. Click Finish.

The newly imported data appears in a profiling session in the Profiling Monitor view. The profiling
project and target are created, if they did not exist already. You can select the session, right-click in the
view, and select one of the options from the context menu to analyze or to display the data that you just
imported. These options are described in the previous sections.

3.3 Profile Analysis View
The Profile Analysis view, shown in Figure 3.10, lets you analyze the profiled data. This view displays
the various events that you have selected for profiling and the images that are profiled for that event. For
each image, you can also see the breakdown of the addresses and the corresponding counter value. The
images and addresses that have a high count on a profile event are potential performance bottlenecks,
which you need to fix.

To launch this view, either double-click the profile session in theProfiling Monitor view, or select the
profile session in theProfiling Monitor view, right-click, and select Profile Analysis view from the
context menu.

Figure 3.10. Profile Analysis view

The toolbar buttons in the Profile Analysis view have the following meanings:

• – If a debug icon appears to the left of a program name, you can select that program and click

the Debug toolbar button to display information for that program in the Debug view. Refer to
Section 3.4, Debug View, for more information.

• – When you click the Search button, a search panel opens at the bottom of the

Profile Analysis view. Enter either a part of or an entire program name in the Find box and click the
Find button. LPS will locate and highlight each program that contains the string for which you are
searching, one at a time. Continue clicking the Find button to scroll through each instance that is
located in the view. Click the Search button again to close the search panel.

• – You can filter out certain data that is shown in the Profile Analysis view by program name,
count, or percent count. To apply a filter, click the Menu button. Refer to Section 3.3.1, Filtering the
Data in the Profile Analysis View, for details about this feature.
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You can sort on any heading in this view by clicking it. The fields in this view have the following mean-
ings:

• Session – The date and time that you ran the LPS session

• Event – The event for which the statistical data is being displayed

If there are multiple events, use the drop-down menu to select the one you want. To display data for
all of the events, select ALL_EVENTS from the drop-down menu.

• Count – The total number of times the selected event was triggered by all of the programs listed in
the Name column

• Name – The individual programs for which the statistical data is being displayed

Click the arrow to the left of the program name to show the statistical data for all of the processes
contained in that program.

If there is a debug icon to the left of a program name, you can double-click the program name to

display information for that program in the Debug view. Refer to Section 3.4, Debug View, for more
information.

By default, only the program name is displayed. Refer to Section 3.10.2, Customizing the File
Names in LPS Views, for information about displaying the full path name.

• % Count – The percentage of the total number of times that the selected event was triggered by this
program

The background color in this field gives a quick visual cue to show which programs and processes
are taking the most time. By default, a red background indicates the highest percentage. Refer to
Section 3.10.1, Customizing the Background Colors in LPS Views, for information about customiz-
ing or eliminating the background colors.

• Count – The number of times that the selected event was triggered by this program

• Address – The address of each process within this program

Information is displayed in this field only when you click on a program in the Name column.

3.3.1 Filtering the Data in the Profile Analysis View
You can filter out certain data that is shown in the Profile Analysis view by program name or by count.
To apply a filter, click the Menu button in the top right corner of the view. A drop-down menu ap-
pears, as shown in Figure 3.11.

Figure 3.11. Profile Analysis view Filter menu
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In the menu, click on Name Filter, Count Filter, Percent Count Filter, or any combination. A check
mark to the left of the filter name means that the filter is applied to the data. By default, no filters are ap-
plied. You can also select Filters, which opens the Profile Analysis View Filters window, as shown in
Figure 3.12.

Figure 3.12. Profile Analysis View Filters window – Select Filters tab

In the Select Filters tab, select the Name Filter checkbox, Count Filter checkbox, Percent Count Fil-
ter checkbox, or any combination to apply the filters that you want.

Click the Name Filter tab, shown in Figure 3.13, to configure the program names that are used for the
filter. For example, you might choose to filter out all programs that contain the string *-2.3.3.so.
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Figure 3.13. Profile Analysis View Filters window – Name Filter tab

Click the Count Filter tab, shown in Figure 3.14, to select a filter comparison and a value. For example,
you might choose to filter out all programs that had a count less than 9.
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Figure 3.14. Profile Analysis View Filters window – Count Filter tab

The Comparison drop-down menu, shown in Figure 3.15, lets you select a comparison method.

Figure 3.15. Filter Comparison menu

Click the Percent Count Filter tab, shown in Figure 3.16, to select a filter comparison and a value. For
example, you might choose to filter out all programs that had a percentage count less than 15.

LPS Views

30



Figure 3.16. Profile Analysis View Filters window – Percent Count Filter tab

3.4 Debug View
The Debug view, shown in Figure 3.17, provides low-level details for a specific program that you have
profiled. This view is most helpful in pinpointing the exact section of your code that contains any per-
formance bottlenecks, down to the line number.

To launch this view, select a program in theProfile Analysis view that has a debug icon to the left of it
and either double click the program name or click the Debug button in that view’s toolbar.

LPS Views

31



Figure 3.17. Debug view

You can sort on any heading by clicking it. The fields in this view have the following meanings:

• Session – The session for which you are displaying debugging information

• Image – The program for which you are displaying debugging information

• Count – The total number of times the selected event was triggered by the program

• Function – The specific function within the program that you are debugging

• % Count – The percentage of total number of times that the selected event was triggered by the pro-
gram

The background color in this field gives a quick visual cue to show which programs and processes
are taking the most time. By default, a red background indicates the highest percentage. Refer to
Section 3.10.1, Customizing the Background Colors in LPS Views, for information about customiz-
ing or eliminating the background colors.

• Count – The number of times that the selected event was triggered by the program

• Line # – The line number in the function where the profile sample data was collected

• Address – The address in the function where the profile sample data was collected

• Source File – The source file in your source code that contains this function

3.4.1 View Source Button
For the profiled samples that have a line number, you can open the source code for the file, which con-
tains annotations of the profiled sample data. To do this, double-click anywhere in the table row, or click
the View Source button in the Debug view’s toolbar. The source file opens in the Annotated

Editor at the bottom of the LPS perspective.
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3.4.2 Compare Profile Data Button
You can compare profiled data for a single source file, down to a line number, between two different
sessions for that file. Use the following procedure:

1. Open the source file for the first session as follows:

a. Right-click on the session in the Profiling Monitor view and select Analyze.

b. In the Profile Analysis view, double-click on the program name that contains the source file
to list all of the source files for that program in the Debug view.

Note:
There must be a debug icon to the left of the program name in order to list the program’s source
files in the Debug view.

c. Select the source file in the Debug view and click the View Source button in the Debug

view’s toolbar.

The source file for the first session opens in the Annotated Editor at the bottom of the LPS
perspective.

2. Repeat step 1 to open the same source file for the second session.

The source file for the second session opens in the Annotated Editor and the Compare Profile
Data button is activated in the Debug view’s toolbar.

3. Click the Compare Profile Data button.

A side-by-side comparison of the two versions of the source file, down to the line number, is dis-
played in the Annotated Editor.
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3.5 Profile Graphical Analysis View
The Profile Graphical Analysis view, as shown in Figure 3.18, displays the data for an event in an LPS
session in an easy-to-read bar graph or a pie chart. All of the features that are available in the Profile
Analysis view are also available in this view. To display data in this view, go to the Profiling
Monitor view, select a session, right-click, and select Analyze Graphically. Traversing this view is
similar to collapsing or expanding the tree in the Profile Analysis view. To traverse this view, double-
click on a graph or chart to drill down into it. To travel back up to the higher level graph or chart, click
the Back button or use the Backspace key.

Figure 3.18. Profile Graphical Analysis view – bar graph

The events that are listed in the Event drop-down menu in the Profile Analysis view are displayed as a
bar graph or pie chart in this view.

The buttons in the Profile Graphical Analysis view allow you to display the data in different formats
and to filter the data that is shown, as described in the following sections.

3.5.1 Toggling the Sorting Order
You can click the Toggle Sort Order button to change the order in which the data is presented for

the bar graphs and pie charts in the Profile Graphical Analysis view. You can drill down into the bar
graphs and pie charts by double-clicking them. When there are multiple items in the graph or chart,
clicking the Toggle Sort Order button reverses the sorting order from highest to lowest count to lowest
to highest count.
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3.5.2 Displaying the Data in a Bar Graph
Click the Vertical Bars button to display the profiled event data in the form of a vertical bar graph,

as shown in Figure 3.18. Double-click the bar graph to drill down into it. The next panel presents pro-
filed images for the event, similar to that shown in Figure 3.19.

Figure 3.19. Profile Graphical Analysis view – bar graph profiled images

You can drill down further by double-clicking the bar graph again. The next panel presents profiled
samples for that image, similar to that shown in Figure 3.20.
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Figure 3.20. Profile Graphical Analysis view – bar graph image samples

To travel back up to the higher level graph, click the Back button or use the Backspace key.
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3.5.3 Displaying the Data in a Pie Chart
Click the Pie Chart button to display the profiled event data in the form of a pie chart, as shown

in Figure 3.21.

Figure 3.21. Profile Graphical Analysis view – pie chart

Double-click the pie chart to drill down into it. The next panel presents profiled images for the event,
similar to that shown in Figure 3.22.
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Figure 3.22. Profile Graphical Analysis view – pie chart profiled images

You can drill down further by double-clicking the pie chart again. The next panel presents profiled
samples for that image, similar to that shown in Figure 3.23.
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Figure 3.23. Profile Graphical Analysis view – pie chart image samples

To travel back up to the higher level chart, click the Back button or use the Backspace key.

3.5.4 Resetting the View’s Magnification
When you zoom in or out on a bar graph or pie chart in the Profile Graphical Analysis view, you can
reset the magnification to its default value by clicking the Reset button .

3.5.5 Maximizing and Minimizing the Data in the View
To zoom in on the bar graph or pie chart data in the Profile Graphical Analysis view, click the Zoom
in button . To zoom out, click the Zoom out button .

3.5.6 Displaying the Previous Screen in the View
You can drill down into the bar graphs and pie charts by double-clicking them. To return to the previous,
higher level panel, click the Back button . This button is activated only after you drill down into a

graph or chart.
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3.5.7 Filtering the Data in the Profile Graphical Analysis
View

You can filter out certain data that is shown in the Profile Graphical Analysis view by program name
or by count. To apply a filter, click the Menu button in the top right corner of the view. A drop-
down menu appears, as shown in Figure 3.24.

Figure 3.24. Profile Graphical Analysis view Filter menu

In the menu, click on Name Filter, Count Filter, or both. A check mark to the left of the filter name
means that filter is applied to the data. By default, no filters are applied. Refer to Section 3.3.1, Filtering
the Data in the Profile Analysis View, for details about the options in this menu.

Note:
The Percent Count Filter shown in the figure in Section 3.3.1, Filtering the Data in the Pro-
file Analysis View, only applies to the Profile Analysis view. It is not available in the Profile
Graphical Analysis view.
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3.6 Properties View
The Properties view, shown in Figure 3.25, displays the read-only properties for an LPS project, target,
or session. To display data in this view, go to the Profiling Monitor view and simply select a session.

Figure 3.25. Properties view

The toolbar buttons in this view have the following meanings:

• Show Categories button – Click this button to group the properties by category, such as Info

and Profiling, for display, as shown in Figure 3.25. If this option is not selected, all of the properties
will be listed together in alphabetical order.

• Show Advanced Properties button – Click this button to display advanced properties.

Currently, there are no advanced properties for LPS, so clicking this button has no effect.

• Menu button – Click this button to access the drop-down menu that is shown in Figure 3.26.
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Figure 3.26. Properties view menu

In this menu, click on Show Categories, or Show Advanced Properties, or both. A check mark to
the left of the display method indicates that an option has been selected. Currently, there are no ad-
vanced properties for LPS, so selecting the Show Advanced Properties option has no effect.

3.7 Log View
The Log view, shown in Figure 3.27, parses and displays the log written by the OProfile daemon on the
target for the selected LPS session. If the daemon has not written a log, the columns in this view are
empty. To display data in this view, go to the Profiling Monitor view, select a session, right-click, and
select Log.

Figure 3.27. Log view

The fields in this view have the following meanings:

• Log for session – The session for which the log is being displayed

• oprofiled started – The date and time when the OProfile daemon oprofiled began running on the
target

• kernel pointer size – The size of the pointer in the kernel on the target

• Date – The date of the log

• Samples – The sample name

• Count – The count for this sample
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3.8 Profile Settings View
The read-only Profile Settings view, shown in Figure 3.28, gives the settings that were used to profile
an LPS session. These are the settings that you configured if you used a profile launch configuration.
Please refer to Chapter 4, Profile Launch Configurations, for more details. You can also refer to the fol-
lowing site for information about the fields in this view:

http://oprofile.sourceforge.net/doc/controlling.html#controlling-daemon

To display data in this view, go to the Profiling Monitor view, select a session, right-click, and select
Profile Settings.

Figure 3.28. Profile Settings view

The fields in this view have the following meanings:

• Profile settings for session – This field shows the date and time that you ran the session.

• vmlinux – This field shows the name of the vmlinux kernel image file that was used to perform ker-
nel profiling; none indicates that no file was used, so the kernel was not profiled.

• Image Filter – Each profile is stored in a single file by default. If you chose to create separate
sample files, the checkboxes indicate how you chose to separate the data. If no checkboxes are selec-
ted, OProfile separates the data according to its default method.

• Call Graph Depth – A value of 0 means that no call graph sample was collected. A non-zero value
means that call graph profiling was enabled. Although LPS allows you to set the call graph, you can-
not view the call graph in LPS.

• Kernel Separated – If this checkbox is selected, separate per-application profiles were created for
the kernel and kernel modules.

• CPU Separated – If this checkbox is selected, separate profiles were created for each CPU.

• Thread Separated – If selected, separate profiles were created for each thread and each task.

• Lib Separated – If selected, separate per-application profiles were created for the libraries.

• Event Name – This field shows the symbolic event name that has been profiled for that counter; for
example, CPU_CLK.

• Count – This field shows the counter reset value; for example, 100000.
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• Unit Mask – This field shows the unit mask, as given in the events list; for example, 0x0f.

• Profiling Kernel – If this checkbox is selected, the kernel code was profiled.

• Profiling Userspace – If this checkbox is selected, the userspace code was profiled.

3.9 Console View
The Console view allows you to establish a Telnet, SSH, or serial connection to your target. To do this,
click the Open Console button in the Console view’s toolbar and select Target Console from

the menu. The Choose a target dialog appears. Use the drop-down menu to select your target, as shown
in Figure 3.29.

Figure 3.29. Choose a target dialog

If you do not have any targets registered, click Manage targets to register a target with TimeStorm.
After you make a selection, the connection type that will be used (Telnet, SSH, or serial) is displayed in
the dialog, along with the IP address of the selected target. Click OK to start to make the connection.

TimeStorm attempts to make the connection to the target, and a session opens in the Console view, as
shown in Figure 3.30.
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Figure 3.30. Console view

The buttons in the Console view have the following meanings:

Terminate button – Stops a Telnet, SSH, or serial session to a target.

Remove Terminated button – Deletes the output of a terminated Telnet, SSH, or serial session
and closes the console window. This button is activated only after you have used the Terminate
button.

Clear Console button – Deletes all of the console output for a session with a target.

Scroll Lock button – Click this button to stop the fast scrolling of the console output. To re-
sume the fast scrolling, click the Scroll Lock button again.

Pin Console button – When multiple sessions are open, use this button to force a particular ses-
sion to stay on top.

Display Selected Console button – Toggles between multiple open sessions with the target.

Open Console button – Opens a Telnet, SSH, or serial session to a target. You can open mul-
tiple sessions, and either view them one at time or tile them so that they do not overlap.
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3.10 Changing Preferences in LPS Views
You can customize the appearance of the LPS views by selecting Window > Preferences > TimeStorm
> Linux Profiling Suite. The Linux Profiling Suite pane appears in the right side of the Preferences
window, as shown in Figure 3.31.

Figure 3.31. Linux Profiling Suite pane

3.10.1 Customizing the Background Colors in LPS Views
Within the Linux Profiling Suite pane, you can change the background colors for the LPS views to in-
dicate different profiling percentages. The colors give you a quick visual cue to see the problematic
areas of the code that you have profiled.

To customize the colors for the various percentages, simply click the color box that you want to change.
If you do not want to use any background colors to indicate percentages, deselect the Use colors for
profile % in views checkbox. This checkbox is selected by default. After you have made your changes,
click Apply and then click OK to save your changes.

To return to the default settings, click Restore Defaults. To exit the Linux Profiling Suite pane without
saving your changes, click Cancel.

3.10.2 Customizing the File Names in LPS Views
Within the Linux Profiling Suite pane, you also can select the Display full paths of files checkbox if
you want entire path names to be displayed in the views. This option is disabled by default.
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Chapter 4 - Profile Launch
Configurations

Although launch configurations are part of the basic TimeStorm workbench, LPS uses a customized
type of launch configuration called a profile launch configuration. A profile launch configuration is a
saved collection of settings that describes how and where to download profiling data with which to run a
profiling session on your target.

When you invoke a profile launch configuration, LPS connects to your target system, transfers files, and
launches a profiling session. This method of running a profiling session allows you to configure target
information, create LPS project and session information, create timer settings, and select events to pro-
file, all in one package. The profile launch configuration is saved in the workspace so that you can reuse
it as often as desired.

This chapter explains how to access and create profile launch configurations on a TimeStorm host using
LPS, how to download and run those profile launch configurations on a target, and how to edit and de-
lete profile launch configurations.

4.1 Accessing Profile Launch Configurations
You can access profile launch configurations from the toolbar by clicking the Profile button and

choosing the Profile option, or by selecting the Run > Profile option from the main menu.

The profile launch configurations are listed in the Configurations pane. From the Configurations pane,
you can create, execute, edit, or delete profile launch configurations.

4.2 Creating Profile Launch Configurations
After a profile launch configuration is created and saved, you can run it immediately, or you can run it at
a later time. You can also run it again as many times as you want.

To create a profile launch configuration:

1. In the Configurations pane, select LPS - OProfile.

2. Click the New button.

A profile launch configuration template named New_configuration is displayed in the right side of
the Profile window, as shown in Figure 4.1.
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Figure 4.1. Creating a profile launch configuration

3. In the Name field, replace the default name of New_configuration with a unique, descriptive name
for your profile launch configuration.

4. Fill in the required information for each of the panels, as described in Section 4.2.1, Target Panel,
Section 4.2.2, Project Panel, Section 4.2.3, Run Panel, Section 4.2.4, Options Panel, and Sec-
tion 4.2.5, Events Panel.

5. Click the Apply button to save a new profile launch configuration or to save changes to an existing
profile launch configuration.

6. Click the Profile button to execute the profile launch configuration and begin profiling. Refer to
Section 4.3, Executing Profile Launch Configurations, for more information.

If you want to use this profile launch configuration again in the future, simply select it from the
Configurations pane of the Profile window.
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4.2.1 Target Panel
The Target panel settings, shown in Figure 4.2, configure the connection between the host and the tar-
get. When you run the launch configuration, TimeStorm makes a Telnet, SSH, or serial connection to
the target (depending on what you have configured) in order to execute your application.

Figure 4.2. Target panel

The Target panel includes the following options. The values for these settings depend on how you have
configured your target system and local network.

• Remote – Select this radio button if you are using a remote target. You need to configure the follow-
ing information:

• Target – Select a registered target from the drop-down menu. If you have not yet registered any
targets with LPS, click Manage Targets to open the Targets window. Please refer to Chapter 2,
Target Setup, for details.

• CPU type – The CPU type of your host. After you select a valid target from the drop-down
menu, this field is automatically filled in for you if LPS can load the OProfile module on the tar-
get. Otherwise, an error message is displayed, and you may select the CPU Type manually.

• Target IP – The IP address that identifies your target. After you select a valid target from the
drop-down menu, this field is automatically filled in for you if LPS can load the OProfile module
on the target. Otherwise, an error message is displayed, and you may enter the Target IP manu-
ally.
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• Local – Select this radio button if you are using your local host (the machine where TimeStorm
runs) as your target system. This option is only available on Linux hosts. You need to configure the
following information:

• CPU type – The CPU type of your host

• IP – The IP address that identifies your host

Note:
FTP, SCP, Telnet, and SSH timeout values for launch configurations can be set from the
TimeStorm Preferences panel. From the main TimeStorm menu, select Window >
Preferences and open the TimeStorm > Launch item.

If you are using Telnet and are having problems maintaining a connection to the target when
using this launch configuration, consider increasing the value in the Execution timeout setting.

Settings made in the Launch timeout panel only affect launch configurations; they do not con-
figure timeout settings for the Console view or any other use of FTP, SCP, Telnet, and SSH.

4.2.2 Project Panel
The Project panel settings, shown in Figure 4.3, let you name an LPS project and/or session.

Figure 4.3. Project panel

If you are creating a new project, you may enter a name for the project, or you may leave the LPS
Project field blank and LPS will supply a name for your LPS project. If you have any existing LPS
projects, you may use the drop-down menu to select one of them.

If you leave the Session field blank, LPS will supply a name for the session in the form of a date and
time stamp later when it creates the session. It is recommended that you leave this field blank so that you
can repeatedly launch the same configuration. If you supply a session name and you try to launch the
same configuration again without changing the session, that launch will fail with the following error:

A session already exists with this name.
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4.2.3 Run Panel
The Run panel settings, shown in Figure 4.4, let you determine how the LPS session will be profiled.

Figure 4.4. Run panel

In the Run panel, either you can choose to profile a particular application, or you can run the profiler on
the target for a specified amount of time by selecting the Timed radio button.

• Application – Selecting this radio button means that a particular application will be profiled in this
session. The profiler runs on the target only for the period that the application runs. If you select this
option, you need to configure the following information:

• Application – Use the Browse button to locate the application that you want to profile.

• Arguments – In this field, enter any arguments that the application might require.

• Delay profiling on application startup – If you want to skip profiling at application startup, se-
lect this checkbox and select the amount of time by which the profiling startup is delayed after
the application begins running. By default, this checkbox is not selected, which means that pro-
filing will begin as soon as the application starts running.

• Timed – Selecting this radio button means that you want to configure a specific length of time for
the profiling to occur. Enter the amount of time in the Minutes and Seconds fields.

Profile Launch Configurations

51



4.2.4 Options Panel
The Options panel settings, shown in Figure 4.5, let you configure various profiling options for your
LPS session. You can also refer to the following site for more information about these profiling options:

http://oprofile.sourceforge.net/doc/controlling.html#controlling-daemon

Figure 4.5. Options panel

These fields and checkboxes have the following meanings:

• Kernel image (vmlinux) File – Use the Browse button to select the vmlinux kernel image file that
was generated during a kernel compilation. This file will be used to perform kernel profiling. If you
want to profile your kernel, you must indicate a vmlinux kernel image file to use and you must
deselect the no-vmlinux checkbox to activate this field.

• no-vmlinux – Select this checkbox if you do not want to profile the kernel itself. The total number
of kernel samples is still counted, but no symbol-based results are provided for the kernel or any
modules. This checkbox is selected by default.

• Separate Profiles – Select one or more checkboxes if you want to separate the profiles into different
files. If no checkboxes are selected, all of the profiles will be stored in a single file. Storing the pro-
files in a single file is the default behavior.

• All – Select this checkbox if you want to use all of the following separation options.

• Separate shared library profiles per application – Select this checkbox if you want to create
per-application profiles for the libraries.
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• Separate shared library profiles per application, including kernel – Select this checkbox if
you want to create per-application profiles for the libraries and for the kernel and kernel mod-
ules.

• Separate per CPU profiles – Select this checkbox if you want to create separate profiles for
each CPU.

• Separate per-thread/process files – Select this checkbox if you want to create separate profiles
for each thread and each task.

• Callgraph Depth – Select this checkbox to enable callgraph sample collection with a maximum
depth. Leave this field blank or enter a value of 0 to disable callgraph profiling.

• Kernel vm address start – The beginning address of the kernel vma address in hexadecimal

• Kernel vm address end – The ending address of the kernel vma address in hexadecimal

• Kernel Buffer Size – The number of samples in the kernel buffer

• CPU Buffer Size – The number of samples in the kernel per-CPU buffer. Profiling at a high rate
might help to increase this size if the log file shows an excessive count of sample lost CPU buffer
overflow.

4.2.5 Events Panel
The Events panel settings, shown in Figure 4.6, allow you to select the events for which you want to
profile your LPS session.

Figure 4.6. Events panel

Profile Launch Configurations

53



Note:
You are allowed to select only one event per counter. Additionally, you may not select the
same event for more than one counter. The dark gray background color shown in Figure 4.6 in-
dicates that the event has already been selected for another counter.

These fields and checkboxes have the following meanings:

• CPU Type – This read-only field shows the CPU type for the target that you have selected.

• Number of counters – This read-only field shows the number of counters available for your target.

• Show Selected – If this checkbox is selected, you cannot expand the counters in the Counter/Event
Name field to list the events for the counters. Only the events that you selected are displayed for
each counter, as shown in Figure 4.7. This checkbox is deselected by default.

Figure 4.7. Events panel – showing only events selected

• Counter/Event Name – Expand the counter to show the symbolic event names contained within
each counter. Click the checkbox next to an event name to select that event for profiling. When an
event is selected, a brief description of the event is displayed in the bottom of the Events panel. You
may only choose one event per counter. Also, if you choose a particular event for one counter, you
may not choose the same event for another counter.

• Count – The field shows the counter reset value for the given event. To edit this value, select the
checkbox for the event, click on the counter value, type in the new value, and hit the Enter key.
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• Unit Mask – The field shows the unit mask, as given in the events list.; for example, 0x0f. The de-
fault value is 0, which means there is no unit mask. To edit this value, select the checkbox for the
event, click on the unit mask value, and enter the new mask value in the Unit Mask Editor window,
which is shown in Figure 4.8. Click OK to save your changes. Click Revert to return to the previous
value. Click Defaults to return to the default value for this event. Click Cancel to exit the window
without saving your changes.

Figure 4.8. Unit Mask Editor window

• Profile Kernel – If this checkbox is selected, the kernel code will be profiled.

• Profile Userspace – If this checkbox is selected, the userspace code will be profiled.

4.3 Executing Profile Launch Configurations
Click the Profile button to start downloading and running the selected profile launch configuration on
the target. After you click the Profile button, LPS waits the amount of time specified in the Run panel
before starting.

After the profile launch configuration has finished running, you can select the session for your launch
configuration in the Profiling Monitor view, right-click, and select an option from the context menu to
view and analyze the data. Refer to Section 3.2, Accessing the Features in the Profiling Monitor View,
for more information.
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4.4 Editing Profile Launch Configurations
To edit a profile launch configuration:

1. In the Configurations pane, select the profile launch configuration that you want to edit, as shown
in Figure 4.9.

Figure 4.9. Editing a profile launch configuration

2. Click in the field that you want to edit and enter the new information. You may edit the Name field
or the information in any of the tabs.

3. As soon as you begin to make any changes, the Apply button and the Revert button become active.
If you want to go back to your previous values, click the Revert button. When you have finished
your edits, click the Apply button to save your changes. Once you apply your changes, you cannot
automatically revert to the previous values.
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4.5 Deleting Profile Launch Configurations
To delete a profile launch configuration:

1. In the Configurations pane, select the profile launch configuration that you want to delete.

2. Click Delete. A dialog box opens, as shown in Figure 4.10, asking you to confirm the deletion.

Figure 4.10. Deleting a profile launch configuration

3. Click Yes to remove the profile launch configuration.
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Chapter 5 - Tutorial: Profiling Your
Code with LPS

Trying to find performance bottlenecks in your code to improve efficiency is a difficult task that can be
made easier by using LPS. This chapter is a tutorial that walks you through the steps for using LPS to
profile and analyze an application on your target. You can also use LPS to profile and analyze an applic-
ation on your host, but the examples in this tutorial will show the process that you would use for your
target. Although the example used in this tutorial is a trivial one, it demonstrates how you can use LPS
to quickly and easily profile and analyze your code. Details about LPS features are available in the other
chapters of this document and in the TimeStorm LPS Online Documentation.

In this example, the application was created by using a TimeStorm project and then cross-compiling it
with the appropriate toolchain. Refer to TimeStorm IDE User’s Guide for more information about creat-
ing and cross-compiling a TimeStorm project. However, you can use LPS to profile any application.
You do not necessarily need to create the application as a TimeStorm project.

5.1 Setting Up Your Host and Target
Before using LPS, perform the following steps to prepare your host and target:

1. Install TimeStorm and the LPS plug-in on the host and start them, as described in Getting Started
with TimeStorm.

2. Install OProfile on your target, if it is not already installed. Refer to Section 1.5, LPS Requirements,
in this guide for more information.

3. Configure your target and verify network connectivity, as described in Chapter 2, Target Setup, in
this guide. This includes the following tasks:

a. Register your target and configure the settings for your target, as described in Section 2.1,
Adding a Target to the List of Registered Targets.

b. Verify that there is an active link between the host and the target, as described in
Section 2.4, Checking the Connection from the Host to a Registered Target.

5.2 Opening the LPS Perspective
Open the LPS perspective. To do this, either select Window > Open Perspective > Other from the
main menu and choose LPS from the list that is displayed in the Select Perspective window, or click the
LPS perspective button in the main toolbar.
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5.3 Creating a New Profile Launch Configuration
In the LPS perspective, open the Profile window. To do this, either select Run > Profile from the main
menu, or click the Profile button and choose Profile.

In the Profile window, create a profile launch configuration as follows:

1. In the Configurations pane, select LPS - OProfile.

2. Click the New button.

A profile launch configuration template named New_configuration is displayed in the right side of
the Profile window.

3. In the Name field, replace the default name of New_configuration with a unique, descriptive name
for your profile launch configuration. In this example, shown in Figure 5.1, the name is
Tutorial_plc.

Figure 5.1. Target panel

4. Fill in the required information for each of the panels, as described in the following sections.

Tutorial: Profiling Your Code with LPS
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5.3.1 Configuring the Target Panel
Configure the following information in the Target panel:

1. Click the Remote radio button.

2. Select your target from the drop-down menu. You should have already registered your target, as de-
scribed previously in Section 5.1, Setting Up Your Host and Target. After you select the target, the
CPU type and Target IP fields are filled in automatically, if the OProfile daemon is running on the
target. Otherwise, an error message is displayed, and you may select the CPU type and the data
folder location on the target manually.

Your completed Target panel will look similar to Figure 5.1.

5.3.2 Configuring the Project Panel
Configure the following information in the Project panel:

1. Enter a name for the project, such as Tutorial.

2. Leave the Session field blank and LPS will supply a name for the session in the form of a date and
time stamp later when it creates the session.

Your completed Project panel will look similar to Figure 5.2.

Figure 5.2. Project panel
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5.3.3 Configuring the Run Panel
Configure the following information in the Run panel:

1. Click the Application radio button.

2. In the Application field, use the Browse button to locate the application that you want to profile.

When you click the Browse button, the Choose an executable window opens. Select your applica-
tion from the list and click OK.

In this example, this application does not require any arguments nor does it require setting a timer to
delay profiling for a certain amount of time after it starts up. Therefore, you do not need to change any
other settings in this panel.

Your completed Run panel will look similar to Figure 5.3.

Figure 5.3. Run panel

5.3.4 Configuring the Options Panel
In this example, you will not be profiling the kernel or separating the profile output into individual files,
so you do not need to change any of the settings in the Options panel.

5.3.5 Configuring the Events Panel
Configure the following information in the Events panel:

1. Expand Counter 0 and select CPU_CLK.

2. Expand Counter 1 and select BRANCHES_MISPREDICTED.

3. Expand Counter 2 and select BRANCHES_FINISHED.
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4. Expand Counter 3 and select COMPLETED_INSNS.

5. Select the Show Selected checkbox to display only the events that you chose.

Your completed Events panel will look similar to Figure 5.4.

Figure 5.4. Events panel
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5.3.6 Executing the Profile Launch Configuration
After you have finished configuring the settings in all of the panels, click Apply to save your changes.
Click Profile to start running the profile launch configuration.

While the profile launch configuration is beginning to run, click the Progress button in the bottom

right corner of the LPS perspective. This action opens a Progress window at the bottom of the perspect-
ive so you can see the progress of the profile launch configuration.

After the launch is completed, you will see status messages in the Profiling Monitoring view similar to
those shown in Figure 5.5 while your code is being profiled and the data is being collected.

Figure 5.5. Status messages in the Profiling Monitoring view

The profiling and data collection is complete when the status messages cease and the session name ap-
pears in the Profiling Monitoring view.
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5.4 Analyzing the Profiled Data
After the profiling is completed, you will use LPS to analyze and debug your code. In the Profiling
Monitoring view, select the profiling session that just completed, right-click, and select Analyze, as
shown in Figure 5.6.

Figure 5.6. Selecting the Analyze option

The profiled data is displayed in the Profile Analysis view.
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5.5 Using the Profile Analysis View
In the Profile Analysis view, choose the event from the Event drop-down menu that you want to ana-
lyze. For example, select COMPLETED_INSNS. The application that you profiled is named multiply.
You can see that this application has a debug icon to the left of its name, as shown in Figure 5.7.

Figure 5.7. Profiled data for the multiply program

The debug icon means that you can open that application in the Debug view. To do this, select and
double-click the multiply program.

5.6 Using the Debug View
In Figure 5.8, you can see that the slow multiply function in line 10 of the code has the highest count
in the % Count field. It has used over half of the CPU cycles for all of the functions.

Figure 5.8. Profiled data for the slow_multiply function
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You will want to examine the code for the slow multiply function. To do this, select and double-click
the function name in the Debug view. This action opens a Locate window, as shown in Figure 5.9.

Figure 5.9. Locate window

Note:
Depending on your host’s operating system, the Locate window might look different from the
one shown here.

Find the source code for your application and click OK. Your source code is opened in an annotated C
editor at the bottom of the LPS perspective so that you can perform some further analysis.
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5.7 Analyzing Your Annotated Code
Your source code is annotated in the left column of the editor, as shown in Figure 5.10.

Figure 5.10. Annotated source code editor

The line of code that has taken most of the CPU time is highlighted in cyan. It has taken 244 counts,
which is almost 70% of the total count.

5.8 Modifying Your Code
Repeat the steps described in Section 5.5, Section 5.6, and Section 5.7 to analyze and troubleshoot your
code for each of the events that you profiled.

After you have determined where all of the bottlenecks are, you can make any necessary modifications
to your code to improve the CPU usage for these events.

5.9 Rerunning the Profile Launch Configuration
After you have finished modifying your code, rerun the same profile launch configuration that you ran
in Section 5.3. To do this, click the Profile button in the main menu to open the Profile window, select
the profile launch configuration named Tutorial_plc from the left pane of the window, and click
Profile.
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5.10 Analyzing the Updated Code
After the profiling is complete, go to the Profiling Monitoring view, select the profiling session that
just completed, right-click, and select Analyze. In the Profile Analysis view, select the event named
COMPLETED_INSNS. In Figure 5.11, you can see that the modified code for the multiply program
has a much lower count than the original code did.

Figure 5.11. Improved code for the multiply program

5.11 Comparing the Profiling Sessions
You can also compare the two profiling sessions side-by-side to see how much improvement your modi-
fications have made. To do this, select the more recent session with the modified code in the Profiling
Monitor view, right-click in the view, and select Compare. The Compare Profile Sessions window
opens.

In the Sessions pane, select and double-click the older session. The Compare Profile Sessions window
expands to show data for the two sessions side-by-side. In the Profile Events pane, expand the listing
for one of your events. In Figure 5.12, COMPLETED_INSNS has been selected.
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Figure 5.12. Sessions shown side-by-side

In the Profile Events pane, double-click on the multiply program. The counts for just the multiply

program are displayed in the lower panes, as shown in Figure 5.13. You can see the significant improve-
ment for this program between the two sessions.

Figure 5.13. Counts for the multiply program shown side-by-side

Click Cancel to close the Compare Profile Sessions window.

5.12 Performing Further Analysis
You can continue to make improvements to your code and then repeat the steps listed in this tutorial un-
til your code is optimized.
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